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ANOTACE

Bakalářská práce je lokalizace anglické nápovědy pro aplikaci Autodesk Maya 2020.

Teoretická část seznamuje čtenáře s vybranými oblastmi aplikace Maya a informuje 

o tvorbě implementační části bakalářské práce (webové prezentace) a použitých 

skriptovacích jazycích. Pro větší přehlednost jsou v teoretické části použity obrázky, 

videa, tabulky a hypertextové odkazy.

Implementační část bakalářské práce tvoří webová prezentace obsahující přehlednou 

interaktivní lokalizaci vybraných částí anglické nápovědy aplikace Maya 2020.

Při tvorbě webové prezentace byly, pro větší přehlednost, použity popisky, možnosti 

nastavení, klávesové zkratky, tabulky, ikony, obrázky, hypertextové odkazy, příklady 

a video ukázky.
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TITLE

Simple help for Autodesk Maya I.

ANNOTATION

Bachelor thesis is concerned with the localization of Help in the English language for the 

Autodesk Maya 2020 application.

The theoretical part presents selected areas of the Maya applications to the reader while 

also providing information concerning the creation of the implementation part of the 

bachelor thesis (i.e. web presentation) and the scripting languages utilised. For the sake 

of greater clarity, images, videos, tables and hyperlinks are used in the theoretical part.

The implementation part of the bachelor thesis consists of a web presentation comprising 

a synoptic interactive localization of selected parts of Help in the English language for 

the Maya 2020 application.

When creating a web presentation, labels, setting options, shortcuts, tables, icons, images, 

hyperlinks, examples and video samples were used for the sake of clarity.
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GIF Graphics Interchange Format
NURBS Non-Uniform Rational B-Splines
Subdiv subdivision surfaces
3D trojrozměrný
2D dvojrozměrný
MEL Maya Embedded Language
HUD head-up display
LOD Úroveň detailů
FBX Filmbox
cm centimetr
HTML Hyper Text Markup Language
CSS Cascading Style Sheets
PHP Hypertext Preprocessor
URL Uniform Resource Locator



ÚVOD

V dnešní době je součástí pracovního i soukromého života většiny lidí výpočetní 

a multimediální technika. Lidé se na každém kroku setkávají s počítačovou grafikou. 

S tím je přirozeně spojena potřeba používat aplikace pro práci s 3D grafikou. K předním 

aplikacím pro tvorbu 3D grafiky, již více než dvě desetiletí, patří aplikace Maya.

Vývojář aplikace, společnost Autodesk, zpravidla vydává každý rok novou verzi aplikace 

Maya. Aktuální verze aplikace je Maya 2020. Nápověda společnosti Autodesk k aplikaci 

Maya 2020 je dostupná pouze v angličtině, japonštině a zjednodušené čínštině. Je možné 

konstatovat, že pro českého uživatele, který nemá potřebné znalosti uvedených cizích 

jazyků se zaměřením na 3D grafiku, a nemá zkušenosti s modelováním ve 3D grafice, je 

cizojazyčná nápověda nedostatečná. Tito uživatelé by měli být cílovou skupinou pro 

lokalizaci nápovědy. Existují sice onlinové internetové překladače, ale ty nedokáží ve 

všech případech vystihnout kontext a terminologii. Díky tomu je jejich překlad nepřesný, 

neúplný a nemusí dávat dostatečný smysl pro nápovědu a práci s aplikací Maya.

Lokalizace aplikace Maya 2020 nebyla vytvořena pro českou nápovědu, ani pro 

samotnou aplikaci. Cílem bakalářské práce je lokalizace nápovědy k aplikaci Maya 2020.

Autodesk Maya je rozsáhlá aplikace, tomu odpovídá i rozsáhlost nápovědy.

V nových aktualizovaných vydáních aplikace Maya nedochází k zásadním změnám 

v práci s aplikací. Díky tomu by měla být tato výsledná lokalizace aplikovatelná i na 

nejbližší následující verze aplikace Maya.



1 APLIKACE MAYA

Aplikace Maya je grafická aplikace pro tvorbu 3D digitálního obsahu. První verze 

aplikace vyšla v roce 1998. Název aplikace se během let změnil, ale slovo Maya v názvu 

stále zůstává. Aktuálně je vývojářem aplikace Maya společnost Autodesk a patří 

k předním grafickým aplikacím. Aplikace Maya byla použita při tvorbě úspěšných filmů 

(například Harry Potter a Relikvie smrti - část 2, Ocelová pěst, Zrození Planety opic, 

Transformers 3, Kung Fu Panda 2).

Zdroje [1], [2]

2 ZÁKLADNÍ SEKCE NÁPOVĚDY

Následující kapitoly obsahují přehledné seznámení s aplikací Maya 2020 v oblastech: 

Základy, 3D Souřadnice, Uživatelské rozhraní, Výběry, Prohlížení scény, Vytváření 

a úprava objektů, Transformace objektů, Uzly a atributy, Správa scény a Základní 

ovládání.

V implementační části jsou tato témata podrobněji rozvedena.

2.1 Základy
Aplikace Maya je přední aplikace pro vytváření kompletního 3D digitálního obsahu, 

včetně modelů, animací, vizuálních efektů, her a simulací.

Činnosti, které lze v aplikaci Maya vykonávat, obecně spadají do následujících kategorií:

• Vytváření modelů. Polygony, Non-Uniform Rational B-Splines (NURBS) 

a subdivision surfaces (Subdiv) jsou různé typy objektů s různými způsoby 

modelování. Každý z nich má své výhody, a každý umělec dává přednost práci 

s jiným typem.

o Polygony umožní modelovat povrch vytvořením a přetvořením řady 

jednotlivých povrchových ploch.

o NURB S umožní snadno vytvářet hladký, zakřivený povrch s j ednoduchou 

kontrolou.



o Subdivision surfaces umožní upravit povrch ve vysokém rozlišení 

s minimálními režijními daty, a přitom umožní pracovat s dílčími částmi 

povrchu, jako by byly složeny z polygonů.

• Rigging postav. Většina animací zahrnuj e „postavy“, kloubové modely j ako j sou 

člověk, zvíře, robot nebo cokoli jiného, co se pohybuje. Aplikace May a umožňuje 

definovat vnitřní kostry pro postavy a navázat na ně kůži, aby se vytvořil 

realistický pohyb s deformací.

• Animace. Téměř všechno, na co si v aplikaci Maya vzpomenete, je klíčovatelné 

anebo animovatelné.

• Dynamika, kapaliny a další simulované efekty. Aplikace Maya obsahuje 

komplexní sadu nástrojů pro simulaci efektů ve skutečném světě, jako jsou ohně, 

výbuchy, kapaliny, vlasy a srst, fyzika střetu objektů atd.

• Malování a efekty malování. Aplikace Maya obsahuje neuvěřitelný systém pro 

použití grafického tabletu (nebo myši) k malování na 2D plátna, malování přímo 

na 3D modely, malování k vytváření geometrických objektů, skriptované 

malování atd.

• Osvětlení, stínování a vykreslování (rendering). Pokud chcete vykreslit statický 

obrázek nebo film scény nebo animace, můžete je vytvořit pomocí různých 

vykreslovačů.

Zdroj [3]



V této sekci najdete:

• 3D souřadnice

• Přehled rozhraní

• Výběry

• Prohlížení scény

• Vytváření a úprava objektů

• Transformace objektů

• Uzly a atributy

• Správa scény

• Základní ovládání

2.2 3D Souřadnice

Nejzákladnější vizuální entita je bod. Bod nemá žádnou velikost, ale má polohu.

Pro určení umístění bodů, se nejprve vytvoří libovolný bod v prostoru jako počátek.

Můžeme pak říci, že umístění bodu je tolik jednotek vlevo (nebo vpravo) od počátečního 

bodu, tolik jednotek nahoru (nebo dolů) od počátečního bodu a tolik jednotek dále (nebo 

blíže) než počáteční bod.



Tato tři čísla poskytují 3D souřadnice bodu v prostoru. Například bod má 7 jednotek 

vpravo od počátečního bodu (x), 4 jednotky blíže od počátečního bodu (z) a 3 jednotky 

nahoru od počátečního bodu (y), bod má souřadnice XYZ (7,3,4).

K určení bodů na opačné straně od počátku používáme záporná čísla. Například bod má 

souřadnice XYZ (-5,-2,-1) je tedy 5 jednotek vlevo od počátečního bodu, 2 jednotky dolů 

od počátečního bodu a 1 jednotku dále od počátečního bodu.

Obrázek 2: souřadný systém [3]

V počítačové grafice se nepoužívá výraz, že je o „vlevo/vpravo“, „nahoru/dolů“ nebo 

„blíže/dále“ . Počítačová grafika pojmenovává tři rozměry osa X, osa Y a osa Z.

V nebo Z osa nahoru

V animacích a vizuálních efektech je tradicí používat osu Y jako „nahoru“ nebo 

výškovou osu a osu X a osu Z jako „pozemní“ osy. Některá další odvětví však tradičně 

používají osu Z jako osu nahoru a osu X a osu Y jako pozemní osy.

V aplikaci Maya lze přepínat osu nahoru mezi osou Y a osou Z. Vyberte

Windows > Settings/Preferences > Preferences, a potom klikněte v dialogu

Preferences v levo v Categories na položku Settings. Další informace naleznete v části 

Settings Preferences.

Zdroje [3], [4]



2.3 Přehled rozhraní

Obrázek 3: ikonka pro video [3]

Také: Intro to Maya: Interface Tour (video)

Tato část je stručným shrnutím hlavního rozhraní aplikace Maya. Číslované nadpisy níže 

se vztahují k číslovaným prvkům rozhraní na obrázku.

• Pokud není možné najít hledanou nabídku, je možné, že správná sada nabídek není 

otevřená (viz Nabídky a sady nabídek (menu sets)) . Je možné zvolit také 

Help > Find Menu a zadat název hledané nabídky nebo příkazu.

• Prvky (panely) je možné v hlavním okně zobrazit nebo skrýt pomocí nabídky 

Windows > UI Elements.

• Můžete skrýt všechny prvky na rozhraní pro maximalizaci prostoru a místo toho 

používat rychlé příkazové znaky: the hotbox, Maya Hotkeys a Marking menus.

• Můžete změnit velikost většiny panelů přetažením jejich okrajů, když se objeví 

kurzor se dvěma šipkami.

• Panely můžete uspořádat tak, aby vyhovovaly vašim preferencím tím, že je ukotvíte 

v různých částech okna v aplikaci Maya. Další informace naleznete 

viz Dock and undock windows and panels.

• Chcete-li přiblížit pohled pod ukazatelem myši, například View Panel nebo Graph 

Editor, stiskněte Shift + mezerník. Tím se sbalí všechny ostatní panely ukotvené 

v hlavním okně. Pokud je ukazatel myši nad plovoucím oknem nebo na jiné části 

rozhraní, jako je Channel Box nebo Tool Settings, ovlivní to poslední zobrazení, na 

které jste klikli. Dalším stisknutím Shift + mezerník obnovíte předchozí konfiguraci 

zobrazení.

Zdroj [3]



• Chcete-li zobrazit podokno se zobrazením na celou obrazovku, stiskněte 

Ctrl + mezerník. Funguje to stejným způsobem, jako Shift + mezerník pro zvětšení 

zobrazení, ale také skryje prvky uživatelského rozhraní, jako je Stavový řádek 

(Status line), Poličky (Shelves), Posuvník času atd. Stisknutím Ctrl + mezerník znovu 

obnovíte předchozí konfiguraci prohlížení.

Obrázek 4: ukázka rozhraní [3]

1. Sady nabídek (Menu sets)

Sady nabídek rozdělují typy dostupných nabídek do kategorií: Modeling, 

Rigging, Animation, FX a Rendering. Prvních sedm nabídek aplikace Maya 

v hlavní nabídce je vždy k dispozici a zbývající nabídky se mění v závislosti na 

zvolené sadě nabídek. Více informací viz Nabídky a sady nabídek (menu sets).

2. Nabídky (Menus)

Nabídky obsahují nástroje i akce pro práci na scéně. Hlavní nabídka je v horní 

části okna aplikace Maya. K dispozici jsou také individuální nabídky pro panely 

a volitelná okna. K nabídkám se také dostanete v hlavní nabídce v rychlém 

výběru (hotboxu), kterou můžete otevřít přidržením mezerníku na zobrazovacím 

panelu. Více informací viz Nabídky a sady nabídek (menu sets).



Stavový řádek (Status line) obsahuje ikony pro některé běžně používané obecné 

příkazy, například File > Save, stejně jako ikony pro nastavení výběru objektů, 

přichytávání, rendering a další. K dispozici je také pole pro rychlý výběr, které 

můžete nastavit pro číselný vstup. Kliknutím na svislé oddělovače rozbalíte 

a sbalíte skupiny ikon.

4. Menu uživatelského účtu

Přihlaste se k vašemu účtu Autodesk. Kliknutím získáte další možnosti, například 

správu licence nebo nákup produktů společnosti Autodesk. Zkušební verze také 

ukazuje, kolik dní zbývá do konce její platnosti.

5. Polička (Shelf)

Polička (Shelf) obsahuje ikony pro běžné úkoly uspořádané podle karet 

v základní kategorii. Skutečnou předností poliček je však to, že si můžete vytvořit 

vlastní poličku, a poté pomocí jediného kliknutí vytvořit nástroje nebo zkratky 

příkazů, které jsou odtud rychle přístupné. Více informací viz Poličky (Shelves).

6. Výběr pracovního prostředí (Workspace selector)

Vyberte vlastní nebo předdefinované uspořádání oken a panelů určených pro 

různé pracovní postupy. Zde je zobrazen pracovní prostor Maya Classic. Více 

informací viz Pracovní prostředí (Workspace).

Zdroj [3]



Ikony na pravém konci stavového řádku (Status line) otevírají a zavírají nástroje, 

které často používáte. Zleva doprava jsou ikony Modeling Toolkit, HumanIK 

window, Attribute Editor, Tool Settings a Channel Box/Layer Editor, které j sou 

ve výchozím nastavení zobrazeny.

V pracovním prostoru Maya Classic se tyto nástroje otevírají jako záložky 

v podokně níže, s výjimkou nástrojů nastavení, které se otevírají v plovoucím 

okně. Pomocí karet můžete přepínat mezi otevřenými nástroji nebo kliknutím na 

aktuální kartu sbalíte celý panel. Kliknutím na kteroukoli kartu ve složeném 

podokně ji obnovíte. Můžete také přetáhnout karty a změnit jejich pořadí, nebo 

kliknutím pravým tlačítkem myši na kartu zobrazíte další možnosti.

8. Channel Box

Channel Box umožní upravit atributy a klíčovatelné hodnoty pro vybrané objekty. 

Atributy transformací j sou ve výchozím nastavení zobrazeny, ale můžete změnit, 

které atributy se zde zobrazí.

9. Editor vrstev (Layer Editor)

V Editoru vrstev (Layer Editor) jsou zobrazeny dva typy hladin:

• Display Layers, které se používají k uspořádání a správě objektů ve scéně, 

například k nastavení jejich viditelnosti a volitelnosti.

• Animation Layers, které se používají k prolnutí, zamknutí nebo ztlumení 

více úrovňové animace.

10. Panel zobrazení (View panel)

Panel zobrazení (View panel) nabízí různé způsoby prohlížení objektů ve scéně 

pomocí zobrazení kamery. V závislosti na rozvržení, které používáte, můžete 

zobrazit jeden nebo více zobrazení. Na panelu zobrazení můžete také zobrazit 

různé editory. Panel Toolbar v každém pohledu umožňuje přístup k mnoha 

používaným příkazům, které naleznete v nabídce panelu Zobrazení.



Panel nástrojů (Tool Box) obsahuje nástroje, které neustále používáte k výběru 

a transformaci objektů ve scéně. Pomocí klávesových 

zkratek [Q][W][E][R][T][Y] můžete použít Nástroj pro výběr (Select Tool) [Q], 

Nástroj pro posun (Move Tool) [W], Nástroj pro otočení (Rotation Tool) [E], 

Nástroj pro změnu velikosti (Scale Tool) [R], Zobrazení manipulátorů (Show 

Manipulators) [T] a také pro přístup k Poslednímu použitému nástroji (Last tool 

used) [Y] ve scéně.

12. Tlačítka rychlé rozvržení (Quick layout) a souhrnný přehled (Outliner)

Horní tři tlačítka pro rychlé rozvržení a souhrnný přehled (Outliner) pod sadou 

nástrojů umožní přepínat mezi užitečnými rozvrženími panelu jediným 

kliknutím. Pomocí spodního tlačítka otevřete okno Outliner. Pro více informací, 

jak vytvořit vlastní rozvržení viz Panels and layouts.

13. Posuvník času (Time Slider)

Posuvník času (Time Slider) zobrazuje časové období, které je k dispozici, to je 

definováno v rozsahu posuvníku níže. Posuvník času také zobrazuje aktuální čas, 

klíče na vybraných objektech nebo postavách, Cached Playback status line 

a Time Slider bookmarks. Přetažením přehrávací hlavy nad posuvníkem časové 

osy, v něm můžete „procházet“ animací nebo použít ovládací prvky pro 

přehrávání na pravém konci.

14. Posuvník rozsahu (Range Slider)

Posuvník rozsahu (Range Slider) umožní nastavit čas začátku a konce animace 

scény. Můžete také nastavit rozsah přehrávání, pokud se chcete zaměřit na menší 

část celé animace.

15. Ovládání přehrávání (Playback Controls)

Ovládání přehrávání (Playback Controls) umožní pohybovat s časem a náhledem 

animace podle toho, jak je  nastavený rozsah posuvníku času (Time Slider).



16. Nabídka Anim/Character (Anim/Character menus)

Nabídka Animation nebo Character umožňují přepínat Animation Layer 

a aktuální Character Set.

17. Možnosti přehrávání (Playback Options)

Pomocí možností přehrávání (Playback Options) můžete ovládat, jak vaše scéna 

přehrává animaci, včetně nastavení snímkové frekvence, nastavení opakování, 

audio controls, automatického klíčování a přehrávání v mezipaměti (Cached 

Playback) a také vám poskytuje rychlý přístup k Time Slider preferences.

18. Příkazová řádka (Command line)

Příkazová řádka (Command line) má vlevo oblast pro vkládání jednoduchých 

MEL příkazů a oblast v vpravo, pro zpětnou vazbu. Tuto oblast použijte, pokud 

jste obeznámeni se skriptovacím jazykem MEL aplikace Maya.

19. Řádek nápovědy (Help Line)

Řádek nápovědy (Help Line) ukazuje krátký popis nástrojů a položek menu, 

jakmile procházíte přes ně v uživatelském rozhraní. Tento panel vás také vyzve 

k provedení kroků potřebných k použití nástroje nebo dokončení pracovního 

postupu.

Související témata

• Customize the look and feel of the interface 

V této sekci najdete:

• Nabídky a sady nabídek (menu sets)

• Pracovní prostředí (Workspace)

• Tlačítka pro rychlé rozvržení a souhrnný přehled (Outliner)

• Panel zobrazení (View panel)

• Stavový řádek (Status line)

• Poličky (Shelves)

• Panel nástrojů (Tool Box)



• Editor vrstev (Layer Editor)

• Posuvník času

• Posuvník rozsahu (Range Slider)

• Možnosti přehrávání (Playback Options)

• Ovládání přehrávání (Playback Controls)

• Příkazová řádka (Command line)

• Řádek nápovědy (Help Line)

2.4 Výběry

Základní výběry v aplikaci Maya zahrnují nastavení požadovaného Výběrového režimu 

a použití Select Tool.

Object mode Component mode Soft Selection mode

Obrázek 5: ukázka výběrových režimů [3]

V této sekci najdete:

• Výběrové režimy

• Styly výběru

• Výběr objektů nebo komponentů

• Přidání nebo odebrání objektů nebo komponentů z výběru



• Výběr určitého typu komponent

• Zvýraznění komponent před jejich výběrem

• Změna typu výběru na jiný

• Rozšíření a zúžení velikosti výběru polygonových komponent nebo NURBS 

vrcholů

• Změna výběrové oblasti polygonových komponent nebo NURBS vrcholů

• Výběr více typů komponent (režim Multi)

• Mnohonásobný výběr komponent

• Výběr skrytých komponent

• Použití výběrových masek

• Výběr objektů na základě hierarchie

• Výběr uzlů

• Výběr pouze rodičovských uzlů, nikoli potomků

• Výběr komponent pomocí štětce

• Měkký výběr (Soft Selection) komponent

• Výběr v mrtvém prostoru

• Uložení a znovupoužití výběru

• Vytvoření nevybratelného objektu (template)

• Rodičovská vazba objektů

2.4.1 Výběrové režimy

Existují tři režimy výběru: Hierarchický (Hierarchy), Objektový (Object) 

a Komponentový (Component). Tyto režimy se používají k omezení nebo maskování 

výběru dalších objektů, abyste mohli vybrat pouze ty typy položek, které chcete: nejvyšší 

úroveň v hierarchii uzlů, celé objekty nebo komponenty objektů. Když používáte masku 

výběru, filtrujete nebo maskujete položky, které nechcete vybrat jako součást výběru.

Na stavovém řádku jsou ikony tří režimů.



Obrázek 6: ukázka panelu výběru [3]

Při prvním spuštění aplikace Maya je režim výběru nastaven na objektový. To je užitečné 

pro většinu vaší práce s výběrem v aplikaci Maya, až na několik výjimek. Pokud chcete 

vybrat položky, které byly seskupeny, nastavte režim výběru na Hierarchický.

Tip: pokud nastavíte masku výběru, zůstane nastavena, dokud ji znovu nezměníte. Pokud 

se položka v aplikaci Maya nevybere, zkontrolujte nastavení masky výběru 

a zkontrolujte, zda je správně nastavena.

Komponenty můžete také vybrat v režimu měkký výběr (Soft Selection). Další informace 

ve Výběru objektů nebo komponentů.

Soft Selection modeObject mode Com ponent mode

Obrázek 7: ukázka výběrových režimů [3]

Související témata

• Switch operations between actions and tools

• Výběr objektů nebo komponentů 

Nadřazené téma Výběry



2.4.2 Styly výběru

Styly výběru určují způsob výběru komponent ve scéně. V aplikaci Maya jsou dva styly 

výběru: Marquee a Drag. Styl výběru můžete nastavit v okně Tool Settings (dvojklikem

na ikonu Select tool ) nebo Modeling Toolkit window.

Obrázek 8: ikona Select Tool [3]

Výběr Marquee (výběr oknem)

Výběrem Marquee nakreslíte obdélníkový rámeček na komponenty, které chcete vybrat. 

Výběr výřezu můžete interaktivně upravit přetažením okenního výběru a následným 

přetažením se stisknutou klávesou Alt na nové místo.

Poznámka: mezi způsoby výběru můžete rychle přepínat pomocí klávesy Tab. Pokud 

držíte klávesu Tab po provedení výběru pomocí Marquee, dočasně aktivuje výběr 

pomocí Drag, takže můžete snadno přidávat a odebírat komponenty z vašeho stávajícího 

výběru pomocí Marquee (viz Resize a marquee selection with drag select) .

Výběr Drag (výběr tažením)

Výběr pomocí Drag je podobný Výběru komponent pomocí štětce bez velikosti štětce. 

Tento styl výběru umožňuje přetáhnout kurzor nad komponentami, které chcete vybrat.

Výběr pomocí Drag umožňuje také vybrat vrcholy, pokud se jich kurzor nedotýká, takže 

výběr je rychlý a snadný. Ve výchozím nastavení aplikace Maya je nastavena předvolba 

na zvýraznění a výběr pomocí Drag, nastaven na zvýraznění komponenty, která je 

nejblíže kurzoru.

Tip: vypněte zvýraznění nejbližší komponenty v Select Tool settings nebo v Modeling 

Toolkit, aby se zvýraznily komponenty pouze, pokud je kurzor nad nimi (viz Zvýraznění 

komponent před jejich výběrem).

Související témata

• Výběry

• Resize a marquee selection with drag select

• Mnohonásobný výběr komponent



V této sekci najdete:

• Resize a marquee selection with drag select 

Nadřazené téma Výběry

2.5 Prohlížení scény

Úpravou nastavení kamer, panelu zobrazení, zobrazení objektů a dalších prvků můžete 

usnadnit prohlížení a vytváření scény.

Podívejte se na video níže, kde najdete informace o tom, jak nastavit panel zobrazení 

různými způsoby, včetně použití výchozích kamer a přizpůsobení vzhledu panelu 

zobrazení.

Obrázek 9: video "Maya Basics: How to Set Up the View Panel“  [3]

V této sekci najdete:

•  Změna pohledu pomocí kamery

• Změna pohledu bez pomoci Viewcube

• Zobrazení nebo skrytí objektů a komponentů

• Změna zobrazení objektů

• Změna barvy pozadí zobrazovacího panelu



Zobrazení, skrytí, změna mřížky

• Zobrazení informací o scéně (HUD) na zobrazovacím panelu

• LOD (Úrovně detailu)

• Náhled souborů s FBX Review

• Zobrazení a přehrání vykreslených obrázků a animací

• Klávesové zkratky pro zobrazení

• Procházení scénou

• Změna velikosti manipulátoru

2.5.1 Změna pohledu pomocí kamery

Kameru, která se používá k zobrazení scény, můžete ovládat pomocí panelu zobrazení 

a také pohybovat s touto kamerou. Bez ohledu na to, kterou kameru zvolíte (výchozí 

perspektivní nebo ortografické kamery nebo sestavu kamer, kterou jste vytvořili), vždy 

se díváte na svou scénu pomocí kamery v panelu zobrazení.

Podívejte se na video níže, kde najdete informace o tom, jak pohybovat s kamerami 

v panelu zobrazení pomocí různých nástrojů a příkazů v nabídce View.

Obrázek 10: video "Maya Basics: How to Navigate with Cameras" [3]



Související témata

• Look through a camera or object

• Frame your scene 

V této sekci najdete:

• Control which camera is shown in a view panel

• Tumble, track, dolly, roll, or zoom the camera

• Use the mouse to control camera azimuth, elevation, yaw or pitch

• Frame all or selected objects in a view

• Return to the default view and previous views 

Nadřazené téma Prohlížení scény

2.5.2 Změna pohledu bez pomoci Viewcube
Viewcube není k dispozici ve verzi Maya 2018 a novějších verzích.

Pokud potřebujete rychlým způsobem přepínat mezi pohledy ve výřezu bez Viewcube, 

vytvořte si odtrhávací nabídku v nabídce View Along Axis:

Zdroj [3]



Obrázek 11: přepínání mezi pohledy [3]

1. V aplikaci Maya v nabídce panelu Zobrazení vyberte View > View Along Axis.

2. Dvojklikem na dvě tečkované čáry v horní části nabídky ji odtrhněte tak, aby se 

stala samostatným oknem.

Zdroj [3]



Obrázek 12: odtrhnuti nabídky [3]

Informace o vytváření plovoucích nabídek naleznete v tématu Odtrhávající 

menu v kapitole Nabídky a sady nabídek (menu sets).

3. Nabídku View Along Axis umístěte na libovolné místo a klikněte na osu, kterou 

chcete zobrazit.

Nadřazené téma Prohlížení scény

2.6 Vytváření a úprava objektů

Tato část popisuje, jak vytvořit základní (primitiva) objekty. Jak je replikovat, provádět 

s nimi základní operace, odstranit je  a pomocí různých nástrojů upravit jejich atributy.

Zdroj [3]



Obrázek 13: video "Maya Basic: How to Create Primitive Objects" [3]

V této sekci najdete:

• Typy objektů

• Vytváření základních 3D objektů a křivek

• Kopie vs. instance

• Duplikát

• Vyjmout, kopírovat a vložit

• Odstranit

• Zpět, znovu a opakovat

• Přímé úpravy číselných hodnot

• Component Editor

2.6.1 Typy objektů

Aplikace Maya má několik různých typů objektů, které můžete použít pro různé účely. 

Většina z nich se používá pro modelování objektů, ale existují i jiné „pomocné objekty“, 

které můžete použít pro konstrukci různých prvků ve scéně.

Poznámka: pro rychlý začátek modelování polygonů a NURBS primitiv a kreslení 

křivek (viz Vytváření základních 3D objektů a křivek) .



Polygonové

objekty

(Polygon

objects) Obrázek 14: ukázka polygonového 
objektu [3]

Polygonové objekty jsou často 

nazývány polygonovou sítí. Jsou 

geometrickými 3D objekty

vytvořenými z ploch, hran a vrcholů. 

Polygonová síť se široce používá pro 

mnoho typů 3D modelů vytvořených 

pro hry, filmy a internet.

Další informace o polygonových sítích 

a o všech způsobech, jak je vytvořit 

a upravit, najdete v části Polygonal 

Modeling.

NURBS

objekty

(Non- 

Uniform 

Rational B- 

Splines)

Objekty NURBS jsou 3D geometrické 

objekty tvořené pláty (patches) 

definovaných křivek ve směru U a V. 

Povrch je interpolován mezi řídícími 

body, což má za následek hladký tvar. 

NURBS jsou užitečné pro vytváření 

organických 3D forem, protože jsou 

hladké a používají se převážně pro 

průmyslový design, animaci 

a vědeckou vizualizaci.

Obrázek 15: ukázka NURBS 
objektu [3]

Pro více informací viz NURBS 

Modeling a NURBS overview. Zde 

najdete další informace o tom, co jsou 

NURBS, a o všech způsobech, jak je 

můžete vytvářet a upravovat.



NURBS

křivky

(NURBS

curves)

Obrázek 16: ukázka NURBS 
křivky [3]

Křivky se používají pro konstrukci 

objektů nebo jako další prvky ve scéně. 

3D objekty můžete z křivek vytvářet 

různými způsoby, nebo je použít pro 

věci, jako jsou cesty pohybu pro 

animaci nebo pro řízení deformací.

Další informace o tom, jak nakreslit 

křivky a vytvořit je  jiným způsobem, 

najdete v části Creating NURBS 

curves.

Text

(Text) Ťext
Obrázek 17: ukázka Textu [3]

Text je 3D text, který můžete vytvořit 

pomocí nástroje Type, vyberte 

C reate > Type. To vám umožní 

vytvářet značky, létající loga, titulní 

sekvence a další projekty, které 

vyžadují text.

Pro více informací viz Create polygon 

text.

Konstrukční

rovina

(Construction

planes)

Obrázek 18: ukázka Konstrukční 
roviny [3]

Konstrukční roviny jsou jednoduché 

roviny, které usnadňují vytváření 

objektů, které mají jinou orientaci než 

podél os XYZ, vyberte 

C reate > Construction Plane.

Když vytvoříte konstrukční rovinu 

„živou (Live)“ pomocí nástroje Make 

Live (viz Set a live surface) veškeré 

modelování se zamkne k této rovině.



Obrazová

rovina

(Image

planes)

Obrázek 19: ukázka Obrazové 
roviny [3]

Obrazové roviny j sou 2D roviny 

(mřížky), na které můžete „promítat“ 

různé obrazy, obvykle používané pro 

referenční obrazy při modelování 

objektu nebo jako pozadí pro vaši 

scénu.

Můžete vytvořit buď volné obrazové 

roviny, které nejsou připojeny ke 

kameře (vyberte

C reate > Free Im age Plane), nebo je 

můžete připojit k perspektivní kameře 

(vyberte

View > Image Plane > Im port Image

v panelu perspektivního pohledu).

Pro více informací viz Image planes.

Lokátory

(Locators)

Obrázek 20: ukázka Lokátoru [3]

Lokátory, které se někdy označují 

"null", jsou pomocné objekty, které 

představují pouze polohu v prostoru 

a nejsou renderovány, vyberte 

C reate > Locator.

Přestože lokátory nezní tak moc 

důležitě, jsou to užitečné pomocné 

objekty, například pro rodičovské 

vztahy kloubů postav, objekty, ke 

kterým můžete omezit jiný objekt, 

nebo pro měření vzdálenosti mezi 

dvěma body.



• Vytváření základních 3D objektů a křivek

• Polygonal Modeling

• NURBS Modeling

• NURBS overview

• Creating NURBS curves

• Create polygon text

• Set a live surface

• Image planes

N adřazené tém a Vytváření a úprava objektů

2.6.2 Vytváření základních 3D objektů a křivek

Než začnete modelovat, musíte vytvořit objekty. Nejjednodušší způsob, jak začít 

s modelováním, je vytvoření geometrických primitiv například koule, kostky, válce 

a roviny, které mohou být základem pro složitější objekty. Nakreslené křivky poskytují 

základ pro vytváření 3D objektů, nebo je můžete použít pro jiné účely.

Poznámka: chcete-li zhlédnout video o tom, jak vytvořit primitivy a nakreslit křivky 

viz Vytváření a úprava objektů.

Začínám e s ukázkovými modely

Můžete načíst ukázkové scény obsahující modely, které lze použít jako výchozí bod pro 

vaši vlastní tvorbu. Tyto scény jsou ve výchozím nastavení nainstalovány společně 

s aplikací Maya.

1. Otevřete Content Browser a klikněte na kartu Examples.

2. Otevřete složku s požadovanými modely a následně přetáhněte model na panel 

zobrazení.
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Obrázek 21: Content Browser [3]

V ytváření polygonových prim itiv

Chcete-li vytvořit primitivní polygonový 3D objekt, otevřete na poličce (shelf) kartu 

Polygons a klikněte na některou z ikon 3D tvarů v levé části.

Obrázek 22: polička polygonových objektů [3]

Můžete také vybrat Create > Polygon Primitives a v podnabídce vybrat jeden 

z primitivních tvarů.

Výchozí nastavení pro jednotlivé typy tvarů můžete nastavit vybráním 

C reate > Polygon Primitives > (požadovaný objekt) > □ . Tato nastavení se používají 

při příštím vytvoření těchto primitiv (viz Polygon Primitives Options) .

Další podrobnosti o vytváření polygonových primitiv naleznete v Create polygon 

primitives.

V ytváření NURBS prim itiv

Chcete-li vytvořit primitivní NURBS 3D objekt, otevřete na poličce (shelf) kartu 

Curves/Surfaces a klikněte na některou z ikon 3D tvarů uprostřed poličky za předělem.



Obrázek 23: polička NURBS objektů 3D tvary [3]

Můžete také vybrat C reate > NURBS Primitives, a poté vybrat možnost z podnabídky.

Výchozí možnosti pro jednotlivé typy tvarů můžete nastavit vybráním 

C reate > NURBS Primitives > (požadovaný objekt) > □ . Tato nastavení se používají 

při příštím vytvoření těchto primitiv (viz NURBS Primitives Options) .

Další podrobnosti o vytváření NURBS primitiv naleznete v Create NURBS primitives. 

V ytváření nebo kreslení křivek

Chcete-li vytvořit primitivní křivku NURBS, otevřete na poličce (shelf) kartu 

Curves/Surfaces a v levé části klikněte na ikonu kruhu nebo čtverce.

M Cur ves / Surfaces

o u x & r x x x x c  s  ■%. ^  °5

Obrázek 24: polička NURBS objektů s vyznačeným kruhem a čtvercem [3]

Chcete-li nakreslit křivku, klikněte na některou z ikon křivky napravo od ikony čtverce. 

Následně začněte kliknutím na libovolná místa v panelu pohledu, tím nakreslíte body na 

křivce.

Obrázek 25: polička NURBS objektů s vyznačenými křivkami [3]

Můžete také zvolit C reate > Curve Tools, a poté vybrat možnost z podnabídky.

Výchozí možnosti pro každý z nástrojů křivky můžete nastavit vybráním 

C reate > Curve Tools > (požadovaný nástroj) > □ . Tato nastavení se použijí při 

příštím použití těchto nástrojů k nakreslení křivky (viz CV Curve Tool Options, 

EP Curve Tool Options a Bezier Curve Tool Options) .

Další podrobnosti o kreslení křivek naleznete v Draw curves.



• Typy objektů

• Create polygon primitives

• Create NURBS primitives

• Draw curves

• Content Browser

N adřazené tém a Vytváření a úprava objektů

2.7 Transformace objektů

Transformace mění polohu, velikost a orientaci objektu, ale nezmění jeho tvar. 

„Transformace“ je v podstatě efektivní způsob, jak nastavit „umístění, měřítko a rotaci“ 

objektu.

Transformace jsou vztaženy k vztažnému bodu (pivot point) objektu (nebo komponentě) 

a umístěny podél/kolem světových os, os objektu nebo lokálních os.

V aplikaci Maya jsou transformace, které provedete u objektu, uloženy v transformačním 

uzlu. To znamená, že si aplikace Maya pamatuje, že se objekt otočil o 32, 0, 5 stupňů 

a posunul o -3, 6.2, 7 cm ze své původní pozice.

Když seskupíte objekty dohromady, každá skupina si pamatuje své vlastní transformace. 

To vám umožní snadno vytvářet hierarchické animace.

V této sekci najdete:

• Světový prostor, objektový prostor a lokální prostor

• Transformace objektů a komponent

• Změna vztažného bodu (pivot point)

• Zarovnání a přichycení

• Přiřazování hodnot atributu objektu

• Odstranění problému s transformacemi



2.7.1 Světový prostor, objektový prostor a lokální prostor

3D pozice a transformace existují v souřadném systému nazvaném prostory.

Světový prostor je souřadnicový systém pro celou scénu. Jeho počáteční umístění je ve 

středu scény. Mřížka, kterou vidíte v oknech zobrazení, zachovává světové osy prostoru.

Obrázek 26: světový souřadnicový systém [3]

Objektový prostor je souřadnicový systém z pohledu objektu. Počátek objektového 

prostoru je ve vztažném bodu (pivot point) objektu a jeho osy se otáčí s objektem.

Obrázek 27: objektový souřadnicový systém [3]

Lokální prostor je podobný jako objektový prostor. Používá však počátek a osy 

nadřazeného uzlu objektu v hierarchii objektů. To je užitečné, pokud jste 

netransformovali samotný objekt, ale objekt je součástí skupiny, která je transformována.

Zdroj [3]



Přechod ze světového do objektového prostoru

Přepínání mezi prostory, například mezi světovým a objektovým prostorem, provedete 

dvojklikem nad transformačními nástroji a změnou nastavení v Tool Settings pod 

položkou Axis Orientation.

Obrázek 28: změna souřadnicového systému [3]

Související tém ata

• Transformace objektů

• Změna vztažného bodu (pivot point)

N adřazené tém a Transformace objektů

2.7.2 Transformace objektů a komponentů
Podtémata v této části vysvětlují mnoho různých způsobů, jak umísťovat, otáčet a měnit 

měřítko objektů a komponentů, a to přesně nebo volným způsobem.

Transformace objektů je přesouvání objektů po scéně, zatímco transformace komponentů 

obvykle mění tvar těchto objektů. Další informace o konkrétních transformacích 

komponentů naleznete v tématu Transforming polygon components.

Nástroje posun, otočení a změna měřítka najdete v panelu nástrojů (Tool Box) na levé 

straně okna aplikace Maya.
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Obrázek 29: panel nástrojů [3]

Související tém ata

• Transforming polygon components 

V této sekci najdete:

• Move objects and components

• Rotate objects and components

• Scale objects and components

• Use the combined Move/Rotate/Scale manipulator

• Move, rotate, and scale using precise values

• Move, rotate or scale components proportionally

• Transform components with symmetry

• Transform along different axes

• Transform components with Tweak mode

• Flip objects

• Show a custom manipulator for the selected node

• Lock a manipulator to the current selection

• Preserve textures during transformation



• Reset and freeze transformations

N adřazené tém a Transformace objektů

2.8 Uzly a atributy

Obrázek 30: ikonka pro video [3]

Také: What are nodes and connections in Maya? (video)

Aplikace Maya je postavena na uzlech. „Objekt“, například koule, je sestaven z několika 

uzlů:

• Uzel vytvoření, zaznamenává vlastnosti, které kouli vytvořily.

• Transformační uzel, zaznamenává, j ak se obj ekt posunuj e, rotuj e a mění měřítko.

• Uzel tvaru, uchovává pozice řídicích bodů koule.

Pokud například vyberete C reate > NURBS Primitives > Sphere pro vytvoření koule, 

aplikace Maya vytvoří transformační uzel a uzel tvaru.

Uzel tvaru koule obsahuje matematický popis tvaru koule. Uzel transformace koule 

uchovává posun koule, změnu měřítka, rotaci atd. Uzel tvaru je podřízeným uzlem 

transformace.

Pokud v okně Hypergraph (Windows > General Editors > H ypergraph: H ierarchy)

vyberte Options > Display > Shape Nodes, zobrazí se hierarchie scény s těmito uzly pro 

kouli:

Obrázek 31: ukázka hierarchie [3]



Atribut je vlastnost spojená s uzlem, která může obsahovat hodnotu nebo připojení 

k jinému uzlu. Atributy řídí, chování uzlu. Například transformační uzel má atributy pro 

otočení v X, Y a Z. Můžete nastavit atributy pro ovládání prakticky každého aspektu vaší 

animace.

V aplikaci Maya je mnoho způsobů, jak nastavit atributy pomocí: Attribute Editor, 

Channel Box, Attribute Spread Sheet, výběrů nabídek a MEL.
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Obrázek 32: Channel Box a Atrribut Editor [3]

Každý uzel je vytvořen s určitými výchozími atributy. Některé atributy (například 

Opacity a Color of particle objects) se přidají dynamicky, podle potřeby.

Můžete také přidat své vlastní atributy do jakéhokoli uzlu pro ukládání informací. To je 

často užitečné pro výrazy (expressions) a skripty animace a lze to použít k ovládání 

několika obvyklých atributů pomocí jednoho vlastního atributu.

Upozornění: názvy uzlů a atributů v aplikaci Maya nemohou začínat číslem.



Animace v aplikaci Maya se neomezuje pouze na to, aby se věci pohybovaly. Můžete 

animovat prakticky jakýkoli atribut libovolného uzlu v aplikaci Maya. Atributy, které 

řídí, jak je povrch konstruován, vzhled textury, vliv deformátoru nebo fyzické síly, se 

mohou v průběhu času měnit.

K onstrukční historie

Když pracujete v aplikaci Maya, většina vašich akcí vytváří uzly v konstrukční historii 

objektů, na kterých pracujete. V každém bodě vaší práce je aktuální scéna výsledkem 

všech dosud vytvořených uzlů.

M anipulace s uzly a atributy

Hodně práce v aplikaci Maya zahrnuje přímá manipulace s uzly a atributy pomocí 

manipulátorů.

Manipulátory jsou vizuální objekty, které vám umožňují snadno, konkrétně a vizuálně 

provádět složité úkoly přetažením úchytů a okamžitým zobrazením výsledků.

Pomocí níže uvedeného příkladu vytočení (revolve), můžete vybrat revolve uzel a upravit 

jeho atributy (způsob, vytvoření povrchu) vizuálním zobrazením manipulátoru pomocí 

nástroje Show Manipulator Tool.

Zdroj [3]



To vám umožní řídit atributy (například, jak daleko kolem středového bodu přejde 

povrch) jednoduše přetažením za úchyty.

Můžete také zobrazit manipulátory pro jednotlivé atributy a vizuálně upravit jejich 

hodnoty.

• Dva pohledy na scénu: hierarchický a závislostní

• Typy uzlů

• Change attribute values in the Attribute Editor or Channel Box

• Úprava hierarchie uzlů 

V této sekci najdete:

• Dva pohledy na scénu: hierarchický a závislostní

• Hierarchie scény

• Graf závislosti

• Hierarchie DAG

• Typy uzlů

• Obecné atributy pro uzly

• Vlastní atributy

• Konstrukční historie

• Statické, dynamické a rozšiřující atributy



• Vytváření atributů pomocí vzorových atributů

• Color Chooser

• Zobrazení a úprava atributů

• Úprava hierarchie uzlů

• Zobrazení a změna vstupních a výstupních vztahů mezi uzly

• Změna zobrazení uzlů a atributů

• Připojení uzlů pomocí Connection Editor

• Použití Node Editor k vytvoření sítě uzlů

• Outliner

• Hypergraph přehled

• Přidání metadat do uzlů

2.9 Správa scény

V této sekci najdete:

• Organizace objektů

K přiřazení souvisejících objektů ke scéně můžete použít skupiny, sady, oddíly, 

kontejnery a vrstvy.

• Anotace a měření

Přidávání poznámek, štítků a měřičských objektů může pomoci se správou scén.

• Správa složitých scén

Aplikace Maya nabízí organizační funkce, které vám pomohou spravovat složité 

scény obsahující velké množství geometrie.

• Optimalizace velikost scény

V aplikaci Maya je  k dispozici několik funkcí pro snížení velikosti a složitosti 

scény.



2.9.1 Organizace objektů

K přiřazení souvisejících objektů ke scéně můžete použít skupiny, sady, oddíly,

kontejnery a vrstvy.

Zde jsou popsány různé strategie:

• Groups -  pomocí skupin můžete provádět základní výběr a transformace na celé 

skupině (kolekci) objektů, jako by byly jedním objektem, aniž byste ve 

skutečnosti kombinovali sítě (viz Group objects together) .

• Sets and Partitions -  sada je kolekce objektů, které lze transformovat a vybírat 

jako jeden, aniž by se změnila hierarchie scény. Oddíl je kolekce exkluzivních 

sad s tím, že žádný objekt nemůže být obsažen ve více sadách v rámci stejného 

oddílu (viz Sets and partitions nebo Create and edit sets) .

• Display layers -  zobrazení kolekce obj ektů, které j sou transformovány a vybrány 

jednotlivě. Můžete udělat vrstvy neviditelnými, abyste snížili počet objektů ve 

scéně, které znemožňují pohled na další objekt. Můžete také udělat šablonu 

(Template) nebo odkaz (Reference) na vrstvu, takže všechny objekty ve vrstvě 

budou nevybíratelné, ale stále přítomné ve scéně (viz Organize objects on display 

layers).

• Render layers -  můžete přiřadit libovolný objekt k více vrstvám s odlišným 

materiálem v každé vrstvě. To vám umožní vytvořit více obrázků pro každý 

snímek z libovolné kombinace vykreslovačů aplikace Maya (viz Render setup in 

Maya).

• Containers -  kolekce uzlů je reprezentována jedním uzlem kontejneru. Můžete 

publikovat podmnožinu atributů z vnitřních uzlů do uzlu kontejneru.

V této sekci najdete:

• Group objects together

• Parent or unparent objects



• Organize objects in display layers

Když je vaše scéna strukturována s objekty v různých vrstvách pomocí Display 

Layer Editor, můžete uspořádat související prvky vaší scény a selektivně je 

zviditelnit nebo skrýt ve 3D pohledu a učinit je  vybíratelnými nebo 

nevybíratelnými.

• Sets and partitions

• Relationship Editor

• Change the name of one or more objects 

N adřazené tém a Správa scény

2.9.2 Anotace a měření
Při správě scén může pomoci přidáním poznámek, štítků a měřičských objektů.

V této sekci najdete:

• Annotate or document objects

• Measure the distance between two points

• Show parameter or arc-length values on a curve or surface 

N adřazené tém a Správa scény

2.10 Základní ovládání

V této sekci najdete:

• Hlavní menu

• Nabídky panelu Zobrazení

• Základní nástroje

• Růžicové menu (Marking Menus)

• Okno výstupu (Output Window)



2.10.1 Hlavní menu

V této sekci najdete:

• Nabídka File

• Nabídka Edit

• Nabídka Create

• Nabídka Select

• Nabídka Modify

• Nabídka Display

• Nabídka Windows

• Nabídka Cache

• Nabídka Help

Nadřazené téma Základní ovládání

2.10.2 Nabídky panelu Zobrazení 

Zobrazení nebo skrytí nabídek panelu

• Stisknutím Shift + M zapnete nebo vypnete nabídku panelu.

m m
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Obrázek 35: přepínání nabídky panelu [3]

Zdroj [3]



Nabídky panelu se zobrazí nad zobrazením scény.

Obrázek 36: umístění nabídky panelu [3]

Když pracujete s rozvržením, které má více než jeden panel zobrazení, nabídky jsou 

k dispozici samostatně pro každý panel zobrazení a umožňují upravit možnosti 

samostatně pro každý panel.

Obrázek 37: ukázka stavu s více panely zobrazení [3]



V této sekci najdete:

• Nabídka View

• Nabídka Shading

• Nabídka Lighting

• Zvyšování výkonu ve složité scéně

Při práci se složitými scénami se může výkon při interaktivitě zpomalit. Tento 

problém lze napravit několika způsoby.

• Nabídka Show

• Nabídka Renderer

• Nabídka Panels

• Nabídka Stereo 

N adřazené tém a Základní ovládání

Zdroj [3]



3 TVORBA WEBOVÉ PREZENTACE A POUŽITÉ JAZYKY

Struktura a vzhled webové prezentace vychází z nápovědy pro aplikaci Maya 2020. 

Webová prezentace byla vytvořena ve vývojovém prostředí Apache NetBeans.

Vývojové prostředí Apache NetBeans barevně odlišuje zdrojový kód a umožňuje snadné 

refaktorování kódu. Apache NetBeans nabízí editory, průvodce a šablony pro různé 

programovací a skriptovací jazyky. Mezi podporovanými jazyky jsou například HTML5, 

CSS, PHP, JavaScript, Java, C, C++. Apache NetBeans lze nainstalovat do všech 

operačních systémů, které podporují Javu.

Zdroje [6], [7]

K vytvoření webové prezentace byly použity skriptovací jazyky HTML5, CSS, PHP 

a JavaScript.

Základ grafického rozhraní je záměrně vizuálně podobný jako na oficiálních stránkách 

nápovědy aplikace Maya 2020.

^  1 AUTODESK' MAYA'2020 Přehledná nápověda pro aplikaci Autodesk Maya I.

Slovník základních pojmů 
1. Základy 
1. 3D souřadnice
3. Přehled rozhraní +
4. Výběry +
5. Prohlíženi scény +
6. Vytváření a úprava objektu +
7. Transformace objektu +
8. Uzly a atributy +
9. Správa scény +
10. Z ákladtú ovládání +
Zdroje

Přehledná nápověda pro aplikaci Autodesk Maya I.Lokalizace anglické nápovědy
Tyto webové stránky jsou praktická část k bakalářské práci Přehledná nápověda pro aplikaci Autodesk Maya I.

Bakalářská práce je  vypracována v rámci Fakultou eletrotechniky a informatiky Univerzity Pardubice.

Webové stránky obsahuji nápovědu k základní část aplikace Maya 2020.

Vzhledem k  Tomu, že bakalářská práce je lokalizace anglické nápovědy, tak jediným zdrojem je anglická nápověda pro aplikaci Autodesk Maya 2020.

Obrázek 38: výchozí stránka implementační části



Pro lepší orientaci v souborech webové prezentace, jsou soubory rozděleny do tří složek.

Obrázek 39: souborová struktura webové prezentace

Do složky image jsou vloženy všechny použité obrázky a animované GIFy. Soubory 

jsou, pro lepší orientaci, pojmenovány strukturovaně (ve formátu 

„číslo kapitoly_číslo podkapitoly - pořadové číslo obrázku na stránce“).

Název
[■] 3_10-2.png 
fc 3_10-3.png 
fc 3_10-4.gif 
* i 3_11-1.png 

@  3_11-2.gif 
*> 3_11-3.png 

@  3_12-1.png 
@  3_12-2.gif 
fc 3_12-3.png 

@  3_12-4.gif 
fc 3_12-5.png 

0  3_12-6.gif 
@  3_12-7.png

Obrázek 40: část souborové struktury ve složce image



Do složky pages, jsou vloženy všechny stránky webové prezentace. Soubory jsou, pro 

lepší orientaci, pojmenovány strukturovaně (ve formátu 

„číslo kapitoly_číslo podkapitoly“).

1-php 
i 2.php 
j 3.php 
] 3_1.php 

3_2.php 
] 3_3.php 
j 3_4.php 
] 3_5.php 
] 3_6.php 
] 3_7.php 
] 3_8.php 
] 3_9.php 
] 3_10.php 
] 3_11.php 

3_12.php 
i 3_13.php

Obrázek 41: část souborové struktury ve složce pages

Do složky share jsou, pro větší přehlednost v kódu stránek a případně pro přehlednější 

změny obsahu, vloženy všechny společné prvky webové prezentace.

Název

] backToIndex.php 
J  cssOwn.css 
] footer.php 
] header.php 

J  menu.php

Obrázek 42: souborová struktura ve složce share



3.1 HTML5

HTML (Hyper Text Markup Language) je jazyk, kterým je popsána struktura webových 

stránek. Skládá se z prvků informujících webový prohlížeč o způsobu zobrazení obsahu. 

Tyto prvky se označují jako tagy (například <h1> H la v n í  n a d p i s  < /h1> , 

<a> H y p e r t e x to v ý  odkaz < / a > , <p> Tex t  o d s t a v e c  < /p>). Prohlížeč tagy 

nezobrazuje, ale řídí se jimi, při vykreslování obsahu webových stránek.

Zdroj [8]

Například tag <p> se vkládá na začátek odstavce a informuje webový prohlížeč, že zde 

začíná nový odstavec. Za tagem následuje text, případně další tagy. Na konec odstavce 

se vkládá tag < /p> , který informuje webový prohlížeč, že zde odstavec končí.

<hl>
Přehled rozhraní

</hl>
<p><img src="../image/3-2.png" alt = "Ukázka video">

<a href="r-ttps ://www, youtube . : : ~ :.i:
Viz také: Intro to Maya: Interface Tour (video)</a></p>

<p>Tato část je stručným shrnutím hlavního rozhraní aplikace Maya.
Číslované nadpisy níže se vztahují k&nbsp;číslovaným prvkům rozhraní 
na obrázku.</p>

<ul>
<li>

<P>
Pokud není možné najít hledanou nabídku, 
je možné, že správná sada nabídek není otevřená 
(viz <a href="../pages/3__.php">Nabídky a&nbsp;sady 

nabídek (menu sets)</a>). Je možné zvolit také 
<strong>Help&nbsp;>&nbsp;Fxnd Menu</strong> 
a&nbsp;zadat název hledané nabídky nebo příkazu.

</p>
</li>

Obrázek 43: část HTML kódu



Výsledné zobrazení ve webovém prohlížeči se bude řídit pomocí tagů a hodnot uvnitř 

tagů.

Přehled rozhran í

Také: Intro to Maya: Interface Tour (video)

Tato část je stručným shrnutím hlavního rozhraní aplikace Maya. Číslované nadpisy níže se vztahují 
k číslovaným prvkům rozhraní na obrázku.

• Pokud není možné najít hledanou nabídku, je možné, že správná sada nabídek není otevřená 
(viz Nabídky a sady nabídek (menu sets)). Je možné zvolit také Help > Find Menu a zadat 
název hledané nabídky nebo příkazu.

Obrázek 44: výsledek ve webovém prohlížeči

Pomocí HTML se také vkládají do webových stránek obrázky. Vkládání obrázků se 

realizuje pomocí tagu <img>. Uvnitř tagu <img> jsou následně atributy s r c  a a l t . 

Atribut s r c  uvádí cestu k obrázku, který má být vykreslen a atribut a l t  uvádí text, který 

se má zobrazit, pokud je obrázek nedostupný.

3.2 CSS

CSS (Cascading Style Sheets) popisuje, jak má webový prohlížeč zobrazit HTML prvky. 

Pomocí CSS lze najednou nastavit zobrazení více webových stránek, a tím zrychlit práci 

a zpřehlednit HTML kód.

Zdroj [9]



Například lze nastavit styl části webové stránky. Požadovaný obsah se v HTML ohraničí 

tagy <div> a < / d i v > . Poté se tagu <div> přidá atribut class=, ,název požadované stylu 

v CSS“. V CSS se nastaví „ .název požadované stylu v CSS“ a v bloku složených 

závorek se nastaví, jak se má daná část zobrazit. Nastavení se aplikuje na všechny 

ohraničené části.

t d ,  t h ,  c r  {
text-align: left; 
border: lpx solid black; 
font-weight: normál;

}
t r .

>

first {
background-color: gray; 
color: white;

t r :n t h - c h i l d ( e v e n )  { 
background: #DDDDDD;

}

Obrázek 45: část CSS kódu

Pomocí CSS jde také upravit pouze část webové prezentace. Například se může nastavit, 

aby hypertextové odkazy po aktivaci nezměnily barvu, tak jak je to ve výchozím 

nastavení. Hypertextový odkaz je označen pomocí tagu <a> s atributem h r e f  = „cesta 

ke stránce, která se má zobrazit“ . Po tagu <a> s atributem h r e f  následuje text, který se 

má zobrazit uživateli, a poté následuje tag < / a > . Požadovaná stránka může být lokální, 

ale i externí. Formát použití se liší pouze uvedenou cestou.

a : l i n k ,  a ; v i s i t e d  { 
color: blue; 
text-decoration: none;

>

Obrázek 46: část CSS kódu s nastavením tagu <a>

3.3 PHP

PHP (Hypertext Preprocessor) je skriptovací jazyk s otevřeným zdrojovým kódem. 

Používá se například k práci se soubory na serveru, práci s databázemi a omezení práv 

pro uživatele. Uvnitř PHP stránek může být vložen HTML, CSS, JavaScript a PHP kód.

Zdroj [10]



Pomocí PHP kódu je do každé stránky vložena část, která je pro všechny stránky stejná. 

Hlavní výhodou je, přehlednější výsledný kód, případné úpravy společných částí jsou 

rychlejší a je zde menší riziko chyby.

Dále je PHP použit k rozevírání hlavního menu. V každé kapitole je vložena metoda

$ POST["název prom ěnné” ] = h o d n o ta  proměnné, která při načtení stránky 

odešle název a hodnotu proměnné. V menu je následně u každé kapitoly s podkapitolou 

vložena část <?php i f  (($ POST[”n á ze v  prom ěnné” ] ==

"h o d n o ta  p rom ěnné” )) echo ' c h e c k e d = " c h e c k e d " ' ;  ?>, která kontroluje

shodu hodnoty případně získané proměnné s nastaveným názvem proměnné. Pokud je 

shoda, nastaví PHP na komponentě checkbox atribut checked  na hodnotu c h ec k e d , 

a tím se zajistí otevření požadované části.

3.4 JavaScript

JavaScript je programovací jazyk pro programování chování webových stránek. 

JavaScript lze použít i jinde než jen na webových stránkách, například JavaScript 

používají desktopové a serverové programy a také některé databáze, jako svůj 

programovací j azyk.

Zdroj [11]

Použitím JavaScriptu je zvýrazněna položka z menu odpovídající aktuálně zobrazené 

stránce. Pomocí JavaScriptu je do stránky s menu přidána knihovna jQuery. Dále je 

naprogramován cyklus, který projde každý hypertextový odkaz přiřazený do třídy menu. 

Pokud se URL adresa shoduje s hypertextovým odkazem (v případě lokálního odkazu 

s relativní cestou nemusí být shoda 1:1), tak se odkazu přiřadí styl . a c t i v e  z CSS.



ZÁVĚR

Bakalářská práce je  zaměřena na lokalizaci anglické nápovědy pro aplikaci Maya 2020. 

Lokalizace vznikla v reakci na chybějící nápovědu k aplikaci Maya 2020 v českém jazyce 

a omezenou nabídku české literatury s tématikou aplikace Maya.

Rozsáhlost aplikace Maya 2020 a návazně velikost její nápovědy neumožnila vypracovat 

lokalizaci v celém rozsahu nápovědy aplikace. Práce je tedy zaměřena na základní část 

nápovědy.

Pracovní postup na bakalářské práci byl rozdělen do šesti základních fází: příprava 

podkladů (podrobné seznámení s aplikací Maya 2020 a vyhledání odborných zdrojů), 

příprava webové prezentace (implementační část práce), překlad textu a zpracování 

webové prezentace, kontrola webové prezentace včetně opakované kontroly 

srozumitelnosti, korektury a vypracování teoretické části práce.

Lokalizace klade důraz na pochopení problematiky uživatelem s menší znalostí 

anglického jazyka. V práci jsou částečně ponechány anglické názvy, jelikož pro aplikaci 

není dostupná česká lokalizace a uživatel se s nepřeloženými anglickými názvy bude při 

práci s aplikací Maya 2020 setkávat.

Zvolený pracovní postup se osvědčil. Zejména kontrola srozumitelnosti, na které se 

podíleli potencionální uživatelé nápovědy (běžní uživatelé IT a zároveň osoby s menší 

znalostí anglického jazyka). Vznesené dotazy k aplikaci a upozornění na nejasnosti 

v nápovědě byly pro větší přehlednost lokalizace zohledněny i za cenu lehkého odchýlení 

od přesného překladu anglického textu nápovědy.

Práce na implementační části bakalářské práce poskytla možnost využít v praxi znalosti 

získané studiem IT a zároveň využít praktické zkušeností z pracovní činnosti, při které 

dochází denně ke kontaktu s uživateli IT se znalostmi přibližně na úrovni cílové skupiny. 

Tvorba lokalizace ukázala, že u nápovědy k aplikaci nejde pouze o prostý překlad 

cizojazyčného textu, ale je  třeba vytvořit funkční nápovědu pro běžné uživatele.

Výsledkem práce na lokalizaci je  splnění zadaného úkolu a lokalizace může být použita 

jako přehledná nápověda pro aktuální verzi aplikace Maya 2020. Lokalizaci je možné 

použít v praxi nebo také jako výukový materiál.

Implementační část je dostupná na adrese http://zakladni-napoveda-maya.tode.cz/ 

v rozsahu řádově 49 000 slov na 280 stránkách formátu A4.

http://zakladni-napoveda-maya.tode.cz/
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PŘÍLOHA B: SLOVNÍK ZÁKLADNÍCH POJMU
NURBS (Non-Uniform Rational B-Splines) objekty

NURBS objekt obsahuje tyto atributy:

• segmenty (spans)

• sekce (section)

• stupně (degree)

Na NURBS objektu lze vybrat:

• řídící vrchol (Control vertex)

• obálka (Hull)

• povrchový plát (Surface patch)

• isočáry (Isoparm)

• povrchový bod (Surface point)

• povrchový UV (Surface UV)

Polygonové objekty

Polygonový objekt obsahuje tyto atributy:

• dělení (Subdivision)

Na polygonovém objektu lze vybrat:

• hranu (Edge)

• vrchol (Vertex)

• vrchol plošky (Vertex face)

• plošku (Face)

• více (multi) - hrany, vrcholy a plošky

• UV (UV)

Subdiv (subdivision surfaces) - dělené objekty

Subdiv aplikace Autodesk Maya už nepodporuje. Subdiv lze pouze načíst a převést do 

NURBS nebo polygonových objektů.



O statní důležité pojmy:

• vztažný bod (pivot point)

• vykreslování (rendering)

• poličky (Shelves)

• pracovní prostředí (Workspace)

• panel nástrojů (Tool Box)

• skriptovací j azyk MEL (MEL - Maya Embedded Language)

• průhledový displej (HUD - head-up display)

• úrověn detailů (LOD - Level Of Detail)

• souborový formát FBX (FBX - Filmbox)

• sady nabídek (Menu set)


